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Introduction

Compact camera modules are widely used in electronic devices such as mobile phones and 
tablet computers. In order to reduce both the size and number of elements required, the 
optical design will typically incorporate several highly aspheric surfaces. This model 
demonstrates a five element (plus filter) design using the 'Aspheric Even Lens 3D' part 
from the Ray Optics Module part library.

Model Definition

An overview of the optical design of the compact camera module used in this tutorial is 
shown in Figure 1. The prescription for this lens design can be found in Ref. 1. It has a 
7.0 mm focal length, a f/2.4 focal ratio, and a nominal field of view of 36°.

Figure 1: Overview of the Compact Camera Module optical design. In this cross-section view, 
the rays have been colored by release index.

The detailed optical prescription is given in Table 1. Instructions for creating the lens 
geometry sequence (Figure 2) can be found in the Appendix — Geometry Instructions. 
In addition to the parameters used to define the Compact Camera Module geometry, a set 
of parameters are required to define the ray tracing model. These are listed in Table 2.
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TABLE 1:  COMPACT CAMERA MODULE OPTICAL PRESCRIPTION (SEE REF. 1).

Index Name Radius 
(mm)

Conic 
constant

Thickness 
(mm)

Refractive 
index

Diameter
(mm)

0 Object ∞ — ∞ — —

1 Stop ∞ — 0.0000 — 2.50

2 Lens 1 1.679 0.22669364 1.1080 1.544 2.90

Aspheric 
coefficients:

A4 = 9.80281·10-3, A6 = -3.81227·10-2, A8 = 2.39681·10-2, 
A10 = -6.29128·10-3, A12 = -2.75496·10-3, A14 = -2.69638·10-4

3 -9.162 0 0.1000 — 3.05

Aspheric 
coefficients:

A4 = 3.73187·10-2, A6 = -8.91760·10-3, A8 = -5.89384·10-2, 
A10 = 4.41115·10-2, A12 = -1.26858·10-2, A14 = 1.16125·10-3

4 Lens 2 -15.649 0 0.2300 1.632 2.70

Aspheric 
coefficients:

A4 = 6.93172·10-2, A6 = -4.31157·10-2, A8 = 2.33346e·10-2, 
A10 = -2.33074·10-2, A12 = 2.22119·10-2, A14 = -4.84076·10-3

5 3.482 8.70133393 1.1305 — 2.21

Aspheric 
coefficients:

A4 = 5.21579·10-3, A6 = 7.15829·10-2, A8 = -4.60926·10-2, 
A10 = 1.24310·10-2, A12 = 3.32216e·10-2

6 Lens 3 -12.801 0 0.2300 1.632 2.30

Aspheric 
coefficients:

A4 = 3.96000·10-2, A6 = -3.42179·10-2, A8 = 7.75523·10-2, 
A10 = -4.22361·10-2

7 21.119 0 1.0559 — 2.25

Aspheric 
coefficients:

A4 = 1.01117·10-1, A6 = -3.21118·10-2, A8 = 9.03668·10-2, 
A10 = -3.37156·10-2, A12 = -6.52751·10-3

8 Lens 4 -3.266 0.85965815 0.2300 1.544 2.95

Aspheric 
coefficients:

A4 = -4.91398·10-2, A6 = -5.57533·10-3, A8 = 1.31557·10-2, 
A10 = 1.22280·10-3, A12 = -9.54019·10-4, A14 = -2.40349·10-6

9 2.724 0 0.1000 — 3.75

Aspheric 
coefficients:

A4 = -8.88955·10-2, A6 = 2.87927·10-2, A8 = -8.83436·10-3, 
A10 = 1.57329·10-3, A12 = -2.24134·10-4

10 Lens 5 5.272 0 1.0356 1.632 3.90

Aspheric 
coefficients:

A4 = -2.38313·10-2, A6 = 5.50321·10-3, A8 = -9.19080·10-4, 
A10 = -9.80631·10-5

11 -4.681 3.15790955 0.1337 — 4.00

Aspheric 
coefficients:

A4 = -3.17139·10-2, A6 = 3.80781·10-3, A8 = 3.43810·10-4, 
A10 = -3.27888·10-5

12 IR Filter ∞ 0 0.2100 1.516 4.50

13 ∞ 0 0.1363 — 4.50

14 Image Plane ∞ 0 — — 5.00
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Figure 2: The Compact Camera Module geometry sequence. Instructions for creating the lens 
geometry can be found in the Appendix.

TABLE 2:  COMPACT CAMERA MODULE MODEL DEFINITIONS.

Parameter Value Description

λvac 587.56 nm Vacuum wavelength

nref,1 1.544 Lens 1 and 4 refractive index (at 587.56 nm)

nref,2 1.632 Lens 2, 3, and 5 refractive index (at 587.56 nm)

nref,3 1.516 IR filter refractive index (at 587.56 nm)

Dpupil 2.50 mm Entrance pupil diameter

Nring 25 Number of hexapolar rings. (Nrays = 1951)

θ1 0° Field angle 1

θ2 5° Field angle 2

θ3 10° Field angle 3

θ4 15° Field angle 4

Δz -0.5 mm Ray release z-coordinate
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The ray tracing algorithm used by the Geometrical Optics interface computes the refracted 
ray direction based on a discretized geometry via the underlying finite element mesh. In 
this model, a cubic geometry shape order is used in order to reduce the discretization 
error. However, it is sometimes necessary to refine the mesh on certain surfaces in order 
to further reduce the effects of discretization. The aspheric surfaces of the Compact 
Camera Module have been assigned to a cumulative selection (Figure 3) on which the 
mesh has been refined (Figure 4).1

The Compact Camera Module is assumed to be operating in air at room temperature. The 
wavelength is set to λ = 587.56 nm as this is the wavelength at which the refractive indices 
are specified. Other Geometrical Optics features include the use of cumulative selections 
to define obstructions (see Figure 5) and the focal surface. A hexapolar grid release is used 
to launch rays at each of the four field angles. Each release has 25 rings, giving a total of 
1951 rays per field angle. Detailed instructions for creating this model can be found in 
Modeling Instructions.

Figure 3: The Compact Camera Module aspheric surface cumulative selection.

1. This level of mesh refinement is only needed for certain surface types. The default physics-controlled mesh is
often suitable for single physics ray tracing studies when using parts from the Ray Optics Module Part Libraries that
incorporate high-accuracy surfaces such as the spherical and conic lens and mirror parts.
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Figure 4: The Compact Camera Module mesh. This view shows the aspheric surfaces on which 
the mesh has been refined.

Figure 5: The Compact Camera Module obstruction cumulative selection.
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Results and Discussion

The ray diagram for the Compact Camera Module is shown in Figure 6. The lens surfaces 
has been rendered using an expression based on the material refractive index. In this figure 
the rays have been colored according to the radial distance from the centroid of each 
release at the image plane. It can be seen that the outermost ring of rays contribute most 
significantly to the rays aberrations.

The spot diagram for this ray tracing study can be seen in Figure 7. The rays are colored 
according to their radial distance from the center of the entrance pupil. This provides a 
way to visualize the origin of the most aberrant rays.

Figure 6: Ray diagram of the Compact Camera Module where the rays are colored by their 
radial distance from the centroid on the image plane.
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Figure 7: Spot diagram for the Compact Camera Module. The spots have been colored 
according to their radial distance from the center of the entrance pupil.

Reference

1. R.I. Mercado, 2015. Small form factor telephoto camera. US Patent 9 223 118 B2, 
filed Oct. 31, 2013 and issued Dec. 29, 2015.

Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
compact_camera_module

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1: Lens Prescription
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in 
the Label text field. The prescription of the Compact Camera Module (see Table 1) will 
be added when the geometry sequence is inserted in the following section.

Now, load the model definitions (Table 2) for the Compact Camera Module from a text 
file.

Parameters 2: General
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2: General in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_parameters.txt.

C O M P A C T  C A M E R A  M O D U L E

Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in Appendix — Geometry Instructions. Following insertion, the full set of 
parameter definitions will be available in the Parameters node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Compact Camera Module in the Label text 
field.

3 Locate the Units section. From the Length unit list, choose mm.

4 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.
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5 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence.mph.

6 In the Geometry toolbar, click Build All.

7 Click the Orthographic Projection button in the Graphics toolbar.

8 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. Orient the view to place the optical axis (z-axis) horizontal and the y-axis 
vertical. Compare the resulting geometry to Figure 2. The Cumulative Selections 
defining the aspheric surfaces and obstructions can be seen in Figure 3 and Figure 5 
respectively.

C O M P O N E N T  1  ( C O M P 1 )

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, locate the Curved Mesh Elements section.

3 From the Geometry shape function list, choose Cubic Lagrange. The ray tracing algorithm 
used by the Geometrical Optics interface computes the refracted ray direction based on 
a discretized geometry via the underlying finite element mesh. A cubic geometry shape 
order usually introduces less discretization error compared to the default, which uses 
linear and quadratic polynomials.

M A T E R I A L S

Now, define the lens materials. In this tutorial the three lens materials will be assigned a 
refractive index appropriate for the chosen wavelength. However, the material refractive 
indices could be defined as a function of wavelength (and temperature) using one of the 
built-in optical dispersion models.

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 Select Domains 3 and 4 only.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

Property Variable Value Unit Property group

Refractive index, real 
part

n_iso ; nii = n_iso, 
nij = 0

nref1 1 Refractive index
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2 Select Domains 2, 5, and 6 only.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

Material 3 (mat3)
1 Right-click Materials and choose Blank Material.

2 Select Domain 1 only.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation 
section.

3 In the Maximum number of secondary rays text field, type 0. In this simulation stray light 
is not being traced, so reflected rays will not be produced at the lens surfaces.

4 Select the Use geometry normals for ray-boundary interactions check box. In this 
simulation, the geometry normals are used to apply the boundary conditions on all 
refracting surfaces. This is appropriate for the highest accuracy ray traces in single-
physics simulations, where the geometry is not deformed.

5 Locate the Material Properties of Exterior and Unmeshed Domains section. From the 
Optical dispersion model list, choose Air, Edlen (1953). It is assumed that the lenses are 
surrounded by air at room temperature.

Material Discontinuity 1
1 In the Model Builder window, under Component 1 (comp1)>Geometrical Optics (gop) click 

Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never.

Property Variable Value Unit Property group

Refractive index, real 
part

n_iso ; nii = n_iso, 
nij = 0

nref2 1 Refractive index

Property Variable Value Unit Property group

Refractive index, real 
part

n_iso ; nii = n_iso, 
nij = 0

nref3 1 Refractive index
11 |  C O M P A C T  C A M E R A  M O D U L E



Ray Properties 1
1 In the Model Builder window, click Ray Properties 1.

2 In the Settings window for Ray Properties, locate the Ray Properties section.

3 In the λ0 text field, type lambda.

Obstructions
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Image Surface
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image Surface in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image Plane).

Release from Grid 1
1 In the Physics toolbar, click Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 From the Grid type list, choose Hexapolar.

4 Specify the qc vector as

5 Specify the rc vector as

6 In the Rc text field, type D_pupil/2.

7 In the Nc text field, type N_ring.

0 x

dz*tan(theta1) y

dz z

0 x

0 y

1 z
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8 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 2
1 Right-click Release from Grid 1 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 3
1 Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 4
1 Right-click Release from Grid 3 and choose Duplicate.

0 x

tan(theta1) y

1 z

0 x

dz*tan(theta2) y

dz z

0 x

tan(theta2) y

1 z

0 x

dz*tan(theta3) y

dz z

0 x

tan(theta3) y

1 z
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2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

M E S H  1

Next, refine the mesh on the aspheric surfaces.

Free Triangular 1
1 In the Mesh toolbar, click Boundary and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Aspheric Surfaces.

Size 1
1 Right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extremely fine.

Free Tetrahedral 1
1 In the Mesh toolbar, click Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, click Build All.

S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 From the Length unit list, choose mm.

0 x

dz*tan(theta4) y

dz z

0 x

tan(theta4) y

1 z
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5 In the Lengths text field, type 0 10. The second path length is sufficiently long to ensure 
that all rays make it to the image surface.

6 In the Home toolbar, click Compute.

R E S U L T S

Ray Diagram 1
The following steps are used to create a pair of ray diagrams.

1 In the Settings window for 3D Plot Group, type Ray Diagram 1 in the Label text field.

Ray Trajectories 1
In the Model Builder window, expand the Ray Diagram 1 node.

Color Expression 1
1 In the Model Builder window, expand the Ray Trajectories 1 node, then click 

Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.prf. This is the index of each of the release 
features, starting at 1.

Filter 1
1 In the Model Builder window, click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at(0,abs(x))<0.01[mm]. Only 
the tangential rays will be rendered in this view.

Slice 1
1 In the Model Builder window, right-click Ray Diagram 1 and choose Slice. Use this feature 

to show the corss-section profile of the camera lens.

2 In the Settings window for Slice, locate the Expression section.

3 In the Expression text field, type abs(y).

4 Locate the Plane Data section. In the Planes text field, type 1.

5 Locate the Coloring and Style section. From the Coloring list, choose Gradient.

6 From the Top color list, choose Black.

7 From the Bottom color list, choose White.

8 Clear the Color legend check box.
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9 In the Ray Diagram 1 toolbar, click Plot. Orient the view to match Figure 1 to show 
only the tangential rays.

Ray Diagram 2
1 Right-click Ray Diagram 1 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Ray Diagram 2 in the Label text field.

3 Locate the Plot Settings section. From the View list, choose New view.

4 Locate the Color Legend section. Select the Show units check box.

5 In the Model Builder window, expand the Ray Diagram 2 node.

Color Expression 1
1 In the Model Builder window, expand the Results>Ray Diagram 2>Ray Trajectories 1 

node, then click Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel). This is the radial coordinate 
relative to the centroid of each release feature at the image plane.

4 From the Unit list, choose µm.

Filter 1
1 In the Model Builder window, click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose All.

Slice 1
In the Model Builder window, under Results>Ray Diagram 2 right-click Slice 1 and choose 
Disable.

Surface 1
In the Model Builder window, right-click Ray Diagram 2 and choose Surface.

Selection 1
1 In the Model Builder window, right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose All Exteriors.

Surface 1
1 In the Model Builder window, click Surface 1.

2 In the Settings window for Surface, locate the Expression section.
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3 In the Expression text field, type gop.nref_local. This will color the lens surfaces 
according to the material refractive index.

4 Locate the Coloring and Style section. From the Coloring list, choose Gradient.

5 From the Top color list, choose Custom.

6 Click Define custom colors.

7 Set the RGB values to 54, 140, and 203, respectively.

8 Click Add to custom colors.

9 Click Show color palette only or OK on the cross-platform desktop.

10 From the Bottom color list, choose Custom.

11 Click Define custom colors.

12 Set the RGB values to 224, 255, and 255, respectively.

13 Click Add to custom colors.

14 Click Show color palette only or OK on the cross-platform desktop.

15 Clear the Color legend check box.

Transparency 1
1 Right-click Surface 1 and choose Transparency.

2 In the Ray Diagram 2 toolbar, click Plot. Orient the view to match Figure 6 to show 
the all the rays.

Spot Diagram
In the following steps a spot diagram will be created to show the location of the rays in the 
image plane.

1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show units check box.

Spot Diagram 1
In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

Color Expression 1
1 Right-click Spot Diagram 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at(0,gop.rrel). This is the radial coordinate relative 
to the centroid at the entrance pupil for each ray release.

4 In the Spot Diagram toolbar, click Plot.
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5 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 7.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

C O M P A C T  C A M E R A  M O D U L E  G E O M E T R Y  S E Q U E N C E

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Compact Camera Module Geometry 
Sequence in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_parameters.txt.

P A R T  L I B R A R I E S

1 In the Home toolbar, click Windows and choose Part Libraries.

2 In the Model Builder window, under Component 1 (comp1) click 
Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Apertures and Obstructions>

circular_planar_annulus in the tree.

4 Click Add to Geometry.
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C O M P A C T  C A M E R A  M O D U L E  G E O M E T R Y  S E Q U E N C E

Stop
1 In the Model Builder window, under Component 1 (comp1)>

Compact Camera Module Geometry Sequence click Circular Planar Annulus 1 (pi1).

2 In the Settings window for Part Instance, type Stop in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click to expand the Boundary Selections section. In the table, select the Keep check box 
for All.

5 Click to select row number 1 in the table.

6 Click New Cumulative Selection.

7 In the New Cumulative Selection dialog box, type Aspheric Surfaces in the Name text 
field.

8 Click OK. This selection will be used to refine the mesh on the aspheric surfaces.

9 In the Settings window for Part Instance, locate the Boundary Selections section.

10 Click New Cumulative Selection.

11 In the New Cumulative Selection dialog box, type Obstructions in the Name text field.

12 Click OK.

13 In the Settings window for Part Instance, locate the Boundary Selections section.

14 Click New Cumulative Selection.

15 In the New Cumulative Selection dialog box, type All Exteriors in the Name text field.

16 Click OK.

17 In the Settings window for Part Instance, locate the Boundary Selections section.

18 In the table, enter the following settings:

Name Expression Value Description

d0 d0_S 5 mm Diameter, outer

d1 d1_S 2.505 mm Diameter, inner

nix nix 0 Local optical axis, x-component

niy niy 0 Local optical axis, y-component

niz niz 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ √ Obstructions
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P A R T  L I B R A R I E S

1 In the Home toolbar, click Windows and choose Part Libraries.

2 In the Model Builder window, click Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Aspheric Lenses>

aspheric_even_lens_3d in the tree.

4 Click Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the 
Select part variant list.

6 Click OK.

C O M P A C T  C A M E R A  M O D U L E  G E O M E T R Y  S E Q U E N C E

Lens 1
1 In the Model Builder window, under Component 1 (comp1)>

Compact Camera Module Geometry Sequence click Aspheric Even Lens 3D 1 (pi2).

2 In the Settings window for Part Instance, type Lens 1 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_lens1.txt. These files are simplify the 
mapping between the lens prescription and the input parameters for this part. Similar 
files will be used for each of the four remaining lenses.

5 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 2
1 In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.

2 In the Settings window for Part Instance, type Lens 2 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_lens2.txt.

Name Keep Physics Contribute to

Exterior √ All Exteriors

Surface 1 √ Aspheric Surfaces

Surface 2 √ Aspheric Surfaces

Edges √ Obstructions
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5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (pi2).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_1.

8 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 3
1 In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_lens3.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 2 (pi3).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_2.

8 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 4
1 In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.

2 In the Settings window for Part Instance, type Lens 4 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

Name Keep Physics Contribute to

Exterior √ All Exteriors

Surface 1 √ Aspheric Surfaces

Surface 2 √ Aspheric Surfaces

Edges √ Obstructions

Name Keep Physics Contribute to

Exterior √ All Exteriors

Surface 1 √ Aspheric Surfaces

Surface 2 √ Aspheric Surfaces

Edges √ Obstructions
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4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_lens4.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (pi4).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_3.

8 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 5
1 In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.

2 In the Settings window for Part Instance, type Lens 5 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
compact_camera_module_geom_sequence_lens5.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 4 (pi5).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_4.

8 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

Exterior √ All Exteriors

Surface 1 √ Aspheric Surfaces

Surface 2 √ Aspheric Surfaces

Edges √ Obstructions

Name Keep Physics Contribute to

Exterior √ All Exteriors

Surface 1 √ Aspheric Surfaces

Surface 2 √ Aspheric Surfaces

Edges √ Obstructions
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P A R T  L I B R A R I E S

1 In the Geometry toolbar, click Parts and choose Part Libraries.

2 In the Model Builder window, click Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Spherical Lenses>

spherical_lens_3d in the tree.

4 Click Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the 
Select part variant list.

6 Click OK.

C O M P A C T  C A M E R A  M O D U L E  G E O M E T R Y  S E Q U E N C E

IR Filter
1 In the Model Builder window, under Component 1 (comp1)>

Compact Camera Module Geometry Sequence click Spherical Lens 3D 1 (pi7).

2 In the Settings window for Part Instance, type IR Filter in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (pi6).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type T_5.

Name Expression Value Description

R1 0 0 m Radius of curvature, surface 1 (+convex/
-concave)

R2 0 0 m Radius of curvature, surface 2 (-convex/
+concave)

Tc Tc_F 0.21 mm Center thickness

d0 d0_F 4.5 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 1

d2_clear 0 0 m Clear aperture diameter, surface 2
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7 Locate the Boundary Selections section. In the table, enter the following settings:

Image Plane
1 In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Image Plane in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
IR Filter (pi7).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type T_6.

7 Locate the Boundary Selections section. In the table, select the Keep check box for All.

8 In the Geometry toolbar, click Build All.

9 Click the Orthographic Projection button in the Graphics toolbar.

10 In the Model Builder window, click Compact Camera Module Geometry Sequence.

11 In the Settings window for Geometry, in the Graphics window toolbar, click next to 
Go to Default View, then choose Go to ZY View.

12 Click the Zoom Extents button in the Graphics toolbar. Orient the view to place the 
optical axis (z-axis) horizontal and the y-axis vertical. Compare the resulting geometry 
to Figure 2.

Name Keep Physics Contribute to

Exterior √ All Exteriors

Edges √ Obstructions

Name Expression Value Description

d0 d0_I 5 mm Diameter, outer

d1 0 0 m Diameter, inner
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